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RESUMEN 
EVALUACIÓN DE LA TOLERANCIA DE TORNILLOS DE FIJACIÓN Y ABUTMENTS DE CONEXIÓN 

HEXAGONAL INTERNA ACTIVA PREFABRICADOS Y PERSONALIZADOS 
 

Dentro de los sistemas de implantes dentales existen los abutments diseñados con conexión hexagonal interna 
activa, ésta se caracteriza por presentar un acoplamiento y ajuste por fricción donde no existe espacio entre sus 
componentes. Este diseño permite una mayor estabilidad de las restauraciones sobre los implantes y una mejor 
distribución de fuerzas. Actualmente se ha popularizado el uso de los abutments personalizados fabricados a 
través de sistemas CAD/CAM, capaces de producir un ajuste, asentamiento y contorno anatómico comparable 
con sus análogos prefabricados sin embargo existe poca evidencia que indique que tan similares son entre si 
dimensionalmente. Por tal razón el objetivo de este estudio fue evaluar la tolerancia de los tornillos de fijación 
y los hexágonos de los sistemas abutments de conexión hexagonal interna activa prefabricados y 
personalizados. Para este estudio se utilizó una muestra no probabilística de 10 sistemas 
de abutments prefabricados con sus análogos personalizado, a los cuales se les analizo 13 dimensiones para el 
tornillo-10 longitudinales y 3 angulares, y 7 dimensiones longitudinales para el hexágono. Loa análisis se 
realizaron sobre microfotografías obtenidas con el SEM a través del software Image JfijiÒ. Los resultados 
obtenidos fueron reportados en micras (m) y en grados (°), fueron analizados estadísticamente mediante las 
pruebas t test y U Mann-Whitney; además el grado de tolerancia se analizó descriptivamente con respecto al 
parámetro de tolerancia máxima establecido en la norma ISO 286-1:2010 [<25m]. Todas las medidas fueron 
realizadas por evaluadores calibrados (ICC>0.8).  Al analizar los resultados se observó que no existen 
diferencias estadísticamente significativas entre los abutments personalizados y prefabricados en ninguna de 
las mediciones – tanto en el tornillo como en el hexágono, sin embargo se encontraron discrepancias por parte 
de los abutments personalizados, con respeto al margen de tolerancia aceptado de <25m en las mediciones de 
la longitud completa del tornillo de fijación, de su parte activa  y del diámetro de su cabeza así como también el 
perímetro, el diámetro y la altura del hexágono Aunque estas discrepancias podrían afectar el comportamiento 
mecánico de los abutments, los resultados de este estudio sugieren que los abutments personalizados podrían 
ser utilizados.  

 
Palabras claves: abutment dental, conexión hexagonal interna, abutment personalizado, dimensionamiento 
geométrico, tolerancia   
 

 
 
 
 
 
 
 
 
  



 

 
ABSTRACT 

EVALUATION OF TOLERANCE OF ANCHORS AND PREFABRICATED PERSONALISED INTERNAL ACTIVE 
HEXAGONAL CONNECTION ABUTMENTS 

 
Dental implant systems include internal active hexagonal connection abutments characterised by friction 
coupling, adjustment where there is no space between components and this system permits greater stability of 
restorations and a better force distribution. There has been an increase in the use of prefabricated personalised 
abutments designed with CAM capable of generating adjustment, settling and anatomical contour comparable 
with its prefabricated analogues; however, there is few evidence which indicates how similar they are 
dimensionally. The objective of this study was to evaluate the tolerance of anchor screws and the mentioned 
hexagonal abutment systems. A non-probabilistic sample of ten prefabricated abutment systems and the 
personalised analogues was used with 13 dimensions analysed: ten longitudinal, three angular and 7 
longitudinal of the hexagonal. The analysis was based on micro-photographs obtained with SEM with the Image 
Jfiji software and the units used were micra (µ) and degrees (˚). They were statistically analysed with the t-test 
and U Mann-Whitney tests, the tolerance degree was descriptively assessed with regards to the maximum 
tolerance parameter established by ISO 286-1:2010 [<25µ] norm and all measurements were carried out by 
calibrated evaluators (ICC>0.8). The analysis showed that there are no statistically significant differences 
between personalised and prefabricated abutments – both for anchor or hexagon. However, there were 
discrepancies on the personalised abutments regarding the accepted tolerance of <25µ for the complete 
longitudinal dimension, active portion, head diameter of the anchor, as well as perimeter and height of hexagon. 
Even though these discrepancies could affect the mechanical behaviour of the abutments, the present results 
suggest that personalised abutments could be used. 

  
Key words: dental abutments, internal hexagonal connection, personalised abutment, geometric dimensioning, 
tolerance. 

 

 

 

  



 

1.INTRODUCCIÓN  

Los implantes dentales son un conjunto de múltiples componentes conformados por el 

cuerpo del implante, el abutment, y la parte protésica. En los diseños convencionales de dos 

piezas el implante y el abutment se mantienen unidos por medio de un tornillo de fijación, 

quedando un microgap entre la conexión de estos. Varios estudios han indicado que una vez 

ocurre la oseointegración, el aflojamiento del tornillo y la reabsorción de la cresta ósea, son 

frecuentemente  las complicaciones más comunes asociadas a los implantes dentales y en 

este tipo de fallas se han reportado relaciones directas con el tipo de conexión, dado que al 

enfrentarse el implante y el abutment a cargas repetitivas con la presencia de un microgap en 

su interfase se produce perdida de la precarga provocando el aflojamiento del tornillo, 

afectando el hueso de la cresta ósea alrededor de la conexión. Desde la percepción biológica, 

el microgap presente en la conexión actúa como un nicho bacteriano, favoreciendo procesos 

inflamatorios en los tejidos peri-implantarios generando finalmente reabsorción ósea.  De 

ahí la importancia de una conexión implante-abutment estable y fiable, siendo necesaria para 

la longevidad del implante en boca. (Yao et al., 2014) Por tal razon, las casas fabricantes han 

propuesto el uso de conexiones implante- abutment que permitan una unión íntima y alta 

estabilidad evitando así la presencia de micro movimientos y futuros fracasos biológicos y 

mecánicos; las cuales permiten un acoplamiento mutuo y un contacto íntimo disminuyendo 

la presencia de un espacio en la interfase generando una mejor distribución de fuerzas y 

tensiones. (Yao et al., 2014) 

Existen diferentes tipos de conexiones, una de ellas es la conexión tipo hexágono interno 

activo; esta es la conexión en donde hay presencia de una característica geométrica en forma 

de hexágono que se extiende por debajo y por dentro de la superficie coronal del implante 

(5,5 mm), y que se caracteriza por mantener una especie de ajuste por fricción, donde no 

existe espacio entre los componentes de acoplamiento y las partes son literalmente forzadas 

entre si. (Binon., 2000).  

Actualmente se están implementando otras opciones de fabricación de abutments utilizando 

sistemas de diseño y fabricación asistida por computador (CAD / CAM); los cuales generan 

abutments capaces de producir un ajuste, asentamiento, contorno anatómico y corrección de 

angulaciones comparable con los abutments prefabricados y a la medida que se requieren.  



 

Para reducir costos y personalizar los tornillos de fijación los laboratorios dentales realizan 

homólogos a partir de librerías desarrolladas por ellos mismos en las cuales se implementan 

diferentes marcas de implantes dentales brindándole al odontólogo opciones protésicas y 

además proporcionando diferentes opciones de reparación, diseño y fabricación asistida por 

ordenador (CAD / CAM). (Johansson et al., 2009, Hamilton et al., 2013, Ji-Man P et al., 2014). 

Hay poca evidencia que evalué la tolerancia de los tornillos de fijación y los abutments 

prefabricados y personalizados. Paek et al., [2016] sugieren que tanto el sistema 

personalizado como el prefabricado presentan buena estabilidad y son similares 

dimensionalmente; por el contrario, Mattheos et al., [2016] sugieren que los abutments 

personalizados pueden presentar diferencias morfológicas críticas con respecto a los 

prefabricados. En efecto las diferencias en la geometría transversal producen grandes 

discrepancias en las áreas de contacto en términos de cantidad como de calidad, lo que puede 

traer implicaciones para la estabilidad a largo plazo de la prótesis (Mattheos et al., 2016).  Es 

evidente que aún no existe información suficiente que resuelva estas controversias, además 

no existe literatura que evalué las diferencias morfológicas entre abutments prefabricados 

con sus homólogos de hexagono interno activo, los cuales tienen una amplia demanda. 

 

Por tal razón el proposito de este estudio fue evaluar la tolerancia de los tornillos de fijación 

y hexagono interno activo en abutments prefabricados y personalizados,  para lo cual se 

utilizaron muestras de abutments y tornillos de fijacion prefabricados con sus homologos 

personalizados. Las imágenes se obtuvieron con microscopio electrónico de barrido a 

diferentes magnificaciones, se tomaron las medidas mediante un software y finalmente se 

analizaron comparandolas entre si. 
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2.MARCO TEÓRICO 

BÚSQUEDA DE INFORMACIÓN  

Se seleccionaron y se definieron con base en las siguientes variables de estudio: Tolerancia, 

Tornillos de Fijación, Falla, Abutment, Abutment Prefabricado, Abutment Personalizado que 

fueron definidas así:  

Tolerancia: Es la diferencia entre la medida máxima y mínima o dimensión de la zona dentro 

de la cual ha de quedar la medida practica para que la pieza sea dada como válida. (Lara et 

al., 2013). 

Falla: En los materiales dentales, fractura de cualquier material físico como resultado de la 

carga y la descarga cíclica caracterizada por la fractura, por debajo de su resistencia a la 

tracción final. En prostodoncia, la incapacidad de una prótesis para producir el resultado 

esperado (Glossary of prosthodontic terms., 2017). 

Tornillo de fijación: componente que asegura el abutment al implante dental (Glossary of 

implant terms., 2017). 

Abutment: Parte de un implante dental que sirve para sostener y/o retener una prótesis 

(Glossary of prosthodontic terms., 2017). 

Abutment Prefabricado (Casa Comercial) Sistema realizado por la casa comercial con 

medidas estándar que permite exactitud en la conexión con el abutment. 

Abutment Personalizado (Customized Abutment / customised Abutment): Sistema 

realizado por laboratorios en donde por medio de un software con librerías de conexiones se 

pueden fabricar abutments de varios sistemas de implantes con técnica CAD CAM. (Catalogo 

Phibo). 

Se consultaron las siguientes bases de datos: EMBASE, PubMed, SCIENCEDIRECT, 

ProQuest 

Se utilizaron las siguientes palabras clave:  

Abutment Screw, Screw Loosening, Tolerance, Customised abutment/ customized abutment, 

Original Abutment, No Original Abutment. 
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Se buscaron los siguientes tipos de estudios: Estudios clínicos y longitudinales. 

Búsqueda # 1 Abutment screws OR screw loosening AND Single Implants 

Busqueda # 2 Tolerance AND Abutment screw  

Busqueda # 3 Customised abutments OR customized abutments 

No hubo restricción de lenguaje ni de fechas de publicación. Se buscaron solo estudios en 

humanos, mujeres y adultos mayores de 18 años. 

Se encontraron 115, 201 artículos respectivamente en las siguientes bases de datos; EMBASE 

y PUBMED; de los cuales fueron seleccionados por título 235, luego por abstract 156 y de 

estos se seleccionaron 76 por relevancia.  

Se excluyeron, editoriales, abstracts que no hubieran sido seguidos por una publicación 

posterior.  

MARCO DE REFERENCIA 

Los implantes dentales son dispositivos protésicos, fabricados con materiales aloplásticos; 

los cuales se implantan dentro del hueso, bajo la mucosa oral proporcionando una gran 

retención y soporte para la rehabilitación de dientes ausentes. (Glossary of prosthodontic 

terms. 2005). En la actualidad son la primera opción de tratamiento protésico para pacientes 

que han sufrido la pérdida de uno o más dientes devolviendo funcionalidad y estética a la 

cavidad oral. (Baqain et al., 2012, Shemtov-Yona, et al., 2014) Los implantes dentales poseen 

tres partes principales: el cuerpo, el abutment y la corona; siendo el cuerpo la parte intraósea; 

es decir el implante propiamente dicho, el abutment es la parte donde se fijara la restauración 

definitiva y se encuentra unido al cuerpo del implante gracias al tornillo de fijación que es un 

elemento protésico que funciona como  un conector y permite posicionar al abutment sobre 

el cuerpo del implante logrando un soporte para la inserción de la restauración definitiva. 

(Glossary of prosthodontic terms., 2005, Glossary of implant terms. 2017). 

El mercado actual ofrece variedad de opciones para adquirir sistemas de implantes 

fabricados por diferentes casas comerciales como Zimmer Biomet, Biohorizons, Biomet 3i, 

Nobel Biocare, Miss, entre otras; las cuales ofrecen diversas características para cada sistema. 

Una de las características más importantes en cuanto a sistemas de implantes, es el tipo de 
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conexión, debido a que es diseñado con la finalidad de lograr un acople intimo entre el 

implante y el abutment para evitar fallas tanto biológicas como mecánicas.  Las conexiones 

de esta interfaz se distinguen generalmente por un acople que es superior (externo) o inferior 

(interno) a la superficie coronal del implante. Las conexiones de tipo interno pueden ser 

tanto hexagono interno pasivo que se define como la conexión en donde hay presencia de 

una característica geométrica en forma de hexágono que se extiende por debajo y por dentro 

de la superficie coronal del implante, y se caracteriza porque el ajuste presenta deslizamiento 

donde existe un ligero espacio entre las partes de acoplamiento haciendo que la conexión sea 

pasiva y el hexagono interno activo que se define como la conexión en donde hay presencia 

de una característica geométrica en forma de hexagono que se extiende por debajo y por 

dentro de la superficie coronal del implante y se caracteriza por un acoplamiento de ajuste 

por fricción, donde no existe espacio entre los componentes y las partes son literalmente 

forzadas entre sí y finalmente la conexión tipo cono morse en donde hay presencia de una 

característica geométrica en forma de cono que se caracteriza por una unión de ajuste por 

fricción, donde no existe espacio entre los componentes de acoplamiento lo que permite que 

la fricción que se presenta entre el abutment con el implante sea como un efecto de soldadura 

al frío; entendiendose que la geometría presente en la conexión de la interfaz implante-

abutment es de gran importancia porque es uno de los determinantes primarios de la 

resistencia y la estabilidad, siendo un punto crítico y sinónimo de estabilidad protésica. 

(Binon., 2000) 

Los implantes dentales se encuentran expuestos en la cavidad oral a numerosas condiciones 

que pueden alterar el proceso de oseointegración produciendo fallas biológicas y mecánicas 

que pueden comprometer el funcionamiento, el éxito y la longevidad del implante; con la 

aparición de signos clínicos y radiográficos como lo son el aflojamiento del tornillo, la fractura 

del tornillo, radiolucidez, movilidad, supuración e inflamación. (Davies., et al 2003, Vianna, et 

al., 2013) Esto es un punto importante si se tiene en cuenta que los implantes dentales y sus 

aditamentos protésicos están diseñados para soportar cargas y el comportamiento 

biomecánico de la cavidad oral demanda que la conexión entre el tornillo y el abutment sea 

lo más íntima posible. Desde un punto de vista mecánico, cuando las fuerzas oclusales se 

aplican sobre el sistema de implante, las tensiones se concentran en la conexión y se generan 
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micro movimientos en la interfaz. (Yao et al., 2015; Bacchi, et al., 2015) 

Una de las fallas mecánicas presentadas con mayor frecuencia en el fracaso de implantes 

dentales es el aflojamiento del tornillo generado principalmente por la fatiga del material, 

insuficiente aplicación de torque, presencia de micro movimientos vibratorios y excesiva 

flexión; esta es una de las principales causas de fracaso en un implante único reportado en la 

literatura y se presenta con mayor incidencia en coronas individuales de premolares y 

molares conllevando a la perdida de precarga y consecuentemente a la perdida de la 

función.(Baqain, et al., 2012, Michalakis, et al., 2014)  Se ha demostrado que la pérdida de 

precarga durante la carga oclusal favorece el desajuste de la conexión implante-abutment  y 

podría causar aflojamiento del tornillo, fractura y también afecta a los factores biológicos 

debido a la presencia de un espacio, que puede conducir a la colonización bacteriana y 

finalmente a la periimplantitis; por lo tanto  el tipo de conexión parece tener una influencia 

en la incidencia del aflojamiento del tornillo. La literatura reporta mayor aflojamiento del 

tornillo para sistemas de implantes con conexiones externas que en sistemas de implantes 

con conexiones internas debido a que estas ofrecen importantes ventajas como: distribución 

de carga lateral profunda dentro del implante, amplio compromiso de pared interna que crea 

un cuerpo rígido y unificado, gran acoplamiento que amortigua la vibración e íntimo selle 

antimicrobiano. (Binon., 2000, Gracis, et al., 2012, Junqueira, et al., 2013) 

Varios estudios retrospectivos han evaluado las tasas de complicaciones biológicas y 

mecánicas, un estudio comparó la tasa de supervivencia y la incidencia de las complicaciones 

poscarga entre dos sistemas de conexión de implantes donde analizaron un total de 2.651 

implantes en 1.074 pacientes en un periodo de observación de 3 años encontraron que el 

sistema de conexión interna era más propenso a las complicaciones técnicas como 

aflojamiento o fractura del tornillo, mientras que el sistema de conexión externa fue más 

vulnerable a las complicaciones biológicas (Chae et al., 2015); Otro estudio evaluó las tasas 

de supervivencia y tasa de complicaciones a 5 años de implantes únicos con un sistema de 

conexión interna con una muestra de 124 implantes encontraron una tasa de éxito de 91.9% 

y el 41.2% de los implantes en la región posterior mostró complicaciones post-carga, 

incluyendo la fractura de la corona de fijación y aflojamiento de los tornillos del abutment 

(Cha et al., 2013); mientras que otra investigación a 5 años indicó complicaciones 
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restaurativas de 444 implantes únicos en un periodo de evaluación de 1 de enero 2005 al 31 

de diciembre de 2009 reportando aflojamiento de los tornillos y complicaciones en el 

abutment representados por 17 casos (27,0%) del total de las complicaciones reportadas de 

las restauraciones definitivas. De esos 17 eventos de complicaciones hubo cinco 

aflojamientos del tornillo, tres presentaron fractura del tornillo, dos pérdidas del abutment o 

del tornillo protésico, dos de daños en la cabeza del tornillo o en las estrías y cinco perdidas 

de las coronas no especificadas (Guo et al., 2015).  

Por otro lado, un estudio prospectivo a 12 años evaluó restauraciones unitarias en 31 

pacientes sobre 35 implantes autorroscantes Astra Tech TiOblast® ST encontró que cinco 

sujetos habían experimentado complicaciones técnicas; tres incidencias de aflojamiento del 

tornillo del abutment durante los primeros 5 años (Donati et al., 2015).  

Por último, un estudio multicéntrico prospectivo que evaluó 82 pacientes en un período de 

seguimiento a 5 años después del tratamiento protésico con coronas sobre implantes 

Brånemark para el reemplazo de un solo diente. La tasa de éxito acumulado global fue del 

95,9% para los implantes y el 91,1% para las coronas.  El tornillo del abutment de oro en el 

sistema CeraOne parece haber eliminado el problema de aflojamiento de los tornillos de los 

abutments en el reemplazo de dientes individuales. Los resultados sugieren que el sistema 

Brånemark puede ser utilizado con seguridad para el reemplazo de dientes individuales 

(Scheller et al., 1998). 

En lo que se refiere a la mecánica del tornillo; las fuerzas aplicadas durante el proceso de 

acoplamiento del sistema de implantes son necesarias y esenciales en el mantenimiento de 

la capacidad funcional del sistema antes de soportar algún tipo de restauración. La 

estabilidad del tornillo de fijación está relacionada con varios factores como la forma 

geométrica, la forma de las roscas, el ajuste del componente protésico, el coeficiente de 

fricción del tornillo, la velocidad del apretamiento, la fuerza de apretamiento utilizada, y las 

cargas oclusales aplicadas (Lang, et al., 2002, Bacchi, et al., 2015) 

Al realizar fuerzas de apretamiento sobre dos partes mediante un tornillo con el fin de unirlos 

firmemente, se genera la denominada articulación del tornillo. La articulación del tornillo 

estará sometida tanto a fuerzas de sujeción, que son las fuerzas que mantienen las piezas 

unidas; como a fuerzas de separación, que son las fuerzas que intentan desacoplar las partes. 
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El tornillo se aflojará sólo si las fuerzas externas que intentan separar las piezas son mayores 

que la fuerza que las mantiene unidas, esto quiere decir que las fuerzas de separación deben 

permanecer por debajo del umbral de la fuerza de apretamiento establecida, mas no tienen 

que eliminarse para evitar el aflojamiento del tornillo.  Si la articulación no se desacopla 

cuando se aplica la fuerza, el tornillo no se aflojará. Por lo tanto, los 2 factores primarios 

implicados en el mantenimiento de los tornillos de los implantes son realizar torque de 

apretamiento maximizando la fuerza de sujeción y minimizando las fuerzas de separación de 

las articulaciones. (Siamos, et al., 2002. Winkler, et al., 2003) 

Para lograr articulaciones seguras debe tenerse en cuenta que los tornillos deben elongarse 

para producir una fuerza de sujeción mayor que la fuerza externa que tiende a separar la 

articulación. En el diseño y función de una articulación roscada rígida, la consideración más 

importante desde un punto de vista biomecánico es la fuerza de sujeción inicial desarrollada 

durante el torque inicial aplicado sobre el tornillo. (Siamos, et al., 2002. Winkler, et al., 2003) 

Al realizar la aplicación del torque sobre la cabeza del tornillo de fijación, se generara una 

fuerza rotacional dentro del tornillo que se distribuye a lo largo del sistema de implantes 

básicamente en tres pasos: Primero se generara fricción entre la cabeza del tornillo y el 

abutment, segundo se generara fricción entre las roscas del tornillo y el implante y por último 

se generara tensión dentro del tornillo, llamada precarga; esta tensión dentro del tornillo 

mejorara la resistencia a la fatiga y el efecto de cierre firme en la conexión implante- 

abutment. (Breedin, et al., 1993) 

Existen factores que pueden desempeñar papeles críticos en la estabilidad de la interfaz del 

tornillo, incluyendo los efectos de asentamiento, ajuste, fatiga dinámica, precarga y la 

geometría del tornillo. (Lang, et al., 2003. Paek, et al., 2016) 

La precarga, es un término de ingeniería utilizado en odontología para describir el grado de 

hermeticidad de un tornillo (Glossary of prosthodontic terms. 2005) y Se refiere a la carga 

inicial o tensión inducida en un tornillo al aplicar torque durante el apretamiento, generada 

para mantener las roscas del tornillo firmemente sujetadas a la contraparte de acoplamiento 

del tornillo y mantener las piezas unidas produciendo una fuerza de sujeción o de 

compresión entre los componentes.  Al aplicar el torque se genera una elongación del tornillo 

como respuesta a la tensión generada. Y finalmente la recuperación elástica del tornillo crea 
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la fuerza de sujeción que mantiene la unión de implante y la restauración. El procedimiento 

clínico sugerido para superar los efectos de asentamiento es realizar un reapretamiento del 

tornillo 10 minutos después de la primera aplicación del torque. (Siamos et al., 2002, Khraisat 

et al., 2004, Feitosa et al.,2013); por lo tanto, el principal objetivo del apretamiento de una 

articulación atornillada es conseguir la precarga óptima que maximizará la vida de la fatiga 

del tornillo mientras que ofrece un grado razonable de protección contra el aflojamiento. 

(Burguete, et al., 1994) 

La cantidad de precarga está influenciada principalmente por la cantidad de torque inicial 

aplicado y el diseño geométrico del tornillo, como la longitud del vástago, el número de 

roscas, el área de la superficie, el tipo de aleación del tornillo y la modificación de la superficie 

del tornillo. (Butkevica, et al., 2016), es decir, el diseño geométrico presente en la interfaz 

implante-abutment sumado a la precisión del ajuste de los componentes de acoplamiento 

permiten resistir las fuerzas oclusales; por esto el tornillo de fijación ha estado en constante 

evolución para maximizar la precarga y minimizar la pérdida de torque por fricción. (Siamos 

et al., 2002, Feitosa et al.,2013) 

En una búsqueda por mejorar las propiedades físicas y mecánicas de los tornillos de fijación 

se han aplicado revestimientos sobre la superficie externa a tornillos de titanio. Se reporta 

un revestimiento patentado de teflón, el cual muestran un aumento efectivo en la precarga 

alcanzable para tornillos de aleación de titanio a un costo significativamente menor que su 

homólogo de aleación de oro y tornillos con recubrimientos en aleación de oro puro, también 

se encuentran ya en el mercado. (Binon., 2000) 

Actualmente se han popularizado los aditamentos personalizados sobre implantes y han 

mejorado considerablemente con la introducción del uso de la tecnologia CAD-CAM. La 

implementación de tecnología para el diseño y fabricación asistida por computador (CAD/ 

CAM) se ha incrementado en los últimos 10 años en la implantologia, ofreciendo mejoras 

continuas y desafiando la fabricación de abutments mediante métodos convencionales; 

realizando aditamentos a partir de un bloque solido de material ofreciendo ventajas como 

homogeneidad, biocompatibilidad, altas propiedades mecánicas, menores inexactitudes, 

optimización de los abutments por medio de la corrección de su angulación permitiendo 

mejorar la dirección de la carga oclusal y del contorno gingival. A traves del sistema CAD se 
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logra una más rápida y exacta planeación de lo que se quiere realizar y con el CAM se puede 

lograr una rápida y exacta producción completa de  la estructura que se planeó. (Kapos, et al., 

2009, Malaguti et al., 2011, Paek et al., 2016). 

Gracias a las mejoras continuas que se han implementado en los sistemas CAD/CAM se ha 

ampliado la demanda de este tipo de fabricación frente a los abutments prefabricados. (Kapos 

et al., 2014). La eficacia clínica de los componentes protésicos obtenidos por los diferentes 

procesos de fabricación carece de base tecnológica ya que la tolerancia dimensional de partes 

individuales y su precisión de ensamblaje no se conoce (Malaguti et al., 2011), además no hay 

procedimientos de control estándar disponibles para evaluar dicha tolerancia.  

La inexactitud inherente de los métodos de fabricación de las piezas mecanizadas llevó a 

determinar límites y ajustes permisibles, ya que la exactitud del tamaño no era un factor 

determinante si la función no podría ser satisfecha.  Por lo tanto, la tolerancia se considera 

como la variación de tamaño aceptable en la fabricación y cuando se requiere una condición 

de ajuste específico entre apareamiento de piezas de trabajo, es necesario atribuir una 

asignación, es decir, una desviación ya sea positivo o negativo, a la talla básica para lograr la 

requerida holgura o la interferencia. (International Standard Organization et al., 1988).   

La tolerancia considerada a partir del estudio de la mecánica es la diferencia entre la medida 

máxima y mínima o dimensión de la zona dentro de la cual ha de quedar la medida practica 

para que la pieza sea dada como válida. (Lara., 2013). Al aplicar este concepto a los implantes 

dentales se debe evaluar el aumento del desajuste del tornillo de fijación y el abutment 

fabricado en un laboratorio diferente al de la casa comercial que realiza el maquinado del 

implante; el cual es causado por la fabricación, el procesamiento y el aflojamiento generado 

por las cargas oclusales (Braian et al., 2014).  

El desajuste de rotación de la conexión hexagonal es crítico en las restauraciones de 

implantes de un solo diente, pero no hay procedimientos de control estándar disponibles 

para su evaluación (Malaguti et al., 2011). Dentro de los métodos de evaluación de la 

tolerancia de los tornillos Malaguti et al., [2011] describe un protocolo de medición original 

de la transferencia del concepto mecánico de los grados de tolerancia dimensional al campo 

dental. Los grados de tolerancia en ingeniería relatan los grados de desviación dimensional 

de una medida para la magnitud del valor nominal, estableciendo clases de precisión 
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dimensional. Se hicieron las mediciones de tres grupos de cinco abutments con un 

microscopio de medición óptica (estereomicroscopio) en donde procesaron los datos para 

obtener el grado de tolerancia internacional y posteriormente calcularon el desajuste de 

rotación de la conexión implante abutment. Analizaron abutments UCLA antes de los 

procedimientos de colado, los mismos abutments premaquinados después de los 

procedimientos de colado y pilares de titanio totalmente maquinados.  

Otro método de evaluación de la tolerancia de los tornillos propuesto por Braian et al., [2014] 

consiste en la medición manual de las piezas cilíndricas de los implantes utilizando un 

instrumento micrómetro (CEJ 101) y digital con un microscopio Leica utilizando una 

magnificación × 50 y software Leica (Leica suite de aplicaciones de la versión 3.7.0 de 2010). 

Todas las muestras fueron luego incorporadas en epoxi (EPOFIX Resina Endurecedor, 

Struers). Después de 24 horas, se cortó cada muestra y suelo hasta el punto central utilizando 

un (Phoenix 4000 sistema de preparación de muestras, Buehler) amoladora, con la alineación 

centrada y controlada cuidadosamente de acuerdo con las mediciones cilíndricas anteriores. 

Se realizó una medición inicial de cada componente por separado y en luego con el análogo 

del implante montado se realizó la medición del cilindro/tornillo. Finalmente, las distancias 

entre cada pilar y su correspondiente implante/análogo se midieron en los lados izquierdo y 

derecho de todas las muestras.  

Por otro lado un estudio evaluó a través del microscopio electrónico de barrido SEM, las 

diferencias entre tornillos de retención protésica de las marcas Nobelpharma-oro como 

grupo control y como grupos de prueba implantes 3i de oro (Impla-Med-oro), implante de 

titanio y sistema de implantes soportados en titanio, en donde evaluaron 8 parámetros 

geométricos que fueron: diámetro de la cabeza del tornillo, longitud del tornillo, paso de 

rosca, diámetro mayor, diámetro del cuello, longitud del cuello, ancho de la cabeza y el ancho 

del vástago; que fueron medidos con el sistema Amray 1000-B SEM. Encontraron que al 

intercambiar tornillos de otras casas comerciales puede generar un tipo de falla mecánica 

(Jaarda et al., 1995). 

En otro estudio se seleccionaron 3 sistemas de implantes para análisis: Brånemark (Nobel 

Biocare USA, Inc., Yorba Linda, CA), 3i Implant Innovations, Inc. (Palm Beach Gardens, FL) y 

Bio-Lok International, Inc. (Deerfield Beach, FLORIDA). Para los implantes Brånemark, se 
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utilizaron abutments CeraOne (Nobel Biocare USA, Inc.), para el sistema 3i Implant 

Innovations, se utilizaron abutments (STA), mientras que se utilizaron abutments 

personalizados (Bio-Lok International, Inc.) de una dimensión similar para las muestras de 

implantes Bio-Lok. Usando el software de imagen de National Institutes of Health (Bethesda, 

MD), se hicieron mediciones de la longitud del tornillo, ancho del vástago en la sección media 

y primer y segundo paso de la rosca. Se tomaron 3 mediciones de cada sitio y se promediaron. 

Del tornillo, se utilizaron las fotografías digitales de la cabeza oclusal del tornillo y el 

abutment. y se examinó mediante (SEM), donde se evaluó la distorsión y se mostró una 

estrecha adaptación en la interface abutment / implante para los 3 sistemas (Yousef H et al., 

2005).  

Se describe también el método de evaluación de la tolerancia de los tornillos utilizado por Gil 

et al., [2014] donde la evaluación de los microintervalos, los sistemas de implante y el pilar 

fueron embebidas en una resina de metacrilato de glicol y después de la polimerización, cada 

muestra fue seccionada a lo largo de su eje longitudinal con un disco de diamante de alta 

precisión. Se obtuvo un total de tres diapositivas para cada implante. Las muestras se 

observaron mediante microscopía electrónica de barrido (JEOL 6400, Japón) junto con un 

sistema de análisis de imagen. La sensibilidad de las medidas era 0,2 m.  El comportamiento 

a la fatiga y el límite de fatiga del prototipo se estableció utilizando curvas de la Wöhler 

(estrés - Número de ciclos) que describen la relación entre la amplitud de las tensiones 

cíclicas y el número de ciclos para romperse. Durante la prueba, el sistema de implante y el 

pilar se sometió a dos fuerzas de compresión y laterales cíclicas, sin ningún tipo de limitación 

lateral. Cuarenta muestras se ensayaron. 

Otro estudio evaluó 7 implantes de 10 mm de cada sistema de implante que fueron 

incrustados a una profundidad de 7 mm en bloques cilíndricos de resina acrílica. Las 

unidades ensambladas se montaron en una máquina de prueba de tipo palanca que estaba 

equipada con un dispositivo de recuento automático y sensores de cierre que permitían 

registrar el número de ciclos hasta la falla. Se aplicó una carga cíclica de 100 N perpendicular 

al largo del eje de los conjuntos a una velocidad de 75 ciclos / minuto. Para investigar la 

resistencia de la muestra a la fatiga durante 6 años de la función simulada, se definió un 

objetivo de 1.800.000 ciclos. El mismo operador realizó la preparación y pruebas de las 

https://www.ncbi.nlm.nih.gov/pubmed/?term=Yousef%20H%5BAuthor%5D&cauthor=true&cauthor_uid=16361889
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muestras. La asociación del diseño de la articulación con la ocurrencia de la falla se verificó 

mediante la prueba de probabilidad exacta de Fisher (P .05). Al finalizar la prueba, las 

superficies fracturadas fueron examinadas con un microscopio electrónico de barrido (SEM) 

(EPMA, Shimadzu, Kyoto, Japón). La muestra, preparación y pruebas se realizaron por el 

mismo operador. 

 La fotografía SEM muestra la superficie de fractura del pilar Tornillo en (A) segunda etapa 

(propagación de grietas) y (B) tercera Etapa (fractura) (Khraisat A et al., 2002) 

El autor Mattheos N en el 2016 evaluó los micro-características morfológicos de tres uniones 

implante-abutment, utilizando dos componentes protésicos compatibles y uno original. 

Además, se investigaron posibles correlaciones entre la micromorfología y posibles 

complicaciones funcionales con el uso de análisis de elementos finitos. Para este estudio se 

utilizó Microscopía electrónica de barrido (SEM) e imágenes y mediciones bidimensionales, 

donde las unidades de implante-pilar cortadas se colocaron bajo diferentes aumentos (10x-

500x) a través de un SEM y se fotografiaron digitalmente. Por último, se utilizó un software 

de edición fotográfica calibrado (ImageJ fiji®, Bethesda, MD, EUA) para mediciones en 

fotografías bajo ampliaciones correspondientes a la zona de evaluación. 

Las mediciones de calibración se realizaron entre puntos con dimensiones conocidas y dos 

observadores independientes realizaron las mediciones, que luego fueron promediadas.  Se 

realizaron mediciones adicionales en las tres áreas de contacto de las unidades implante pilar 

donde se espera un contacto estrecho de los componentes, siendo: 

(A) el área del pilar en contacto con el hombro externo del cuello del implante 

(B) el área del pilar en contacto con la conexión interna del implante 

(C) el área del tornillo de tope en contacto con las roscas internas del implante. 

El contacto entre el implante y el pilar en las tres áreas anteriores se evaluó de la siguiente 

manera: Se llevó a cabo la medición de la longitud lineal total del contacto apretado y no 

estanco en cada una de las 3 áreas. La longitud del contacto estanco lineal (TC) entre los 

componentes anteriores en la imagen en sección transversal se midió en mm y también se 

expresó como porcentaje de la longitud de contacto posible total de la zona de apoyo 

respectiva. Además, se examinó la calidad de las superficies en contacto, investigando la 

https://www.ncbi.nlm.nih.gov/pubmed/?term=Khraisat%20A%5BAuthor%5D&cauthor=true&cauthor_uid=12488853
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presencia de anomalías superficiales, microrugosidad, microfisuras o cualquier otro 

desajuste entre las superficies en contacto. 

Las unidades implante-pilar fueron cortadas en el microtomo y fotografiadas bajo diferentes 

aumentos (10X-500X) a través de un microscopio electrónico de barrido. Se reconstruyeron 

modelos de análisis de elementos finitos para cada una de las unidades implante-pilar usando 

las mediciones precisas de la SEM. Las diferencias de tensión, deformación y deformación 

para los tres pilares diferentes se calcularon utilizando ANSYS Workbench v13. (Mattheos N 

et al., 2016) 

En un estudio similar se evaluó tres diferentes tipo de  implantes Strauman con sus 

respectivos  abutments en cortes horizontales  por medio de microscopia electrónica de 

barrido SU1510  con magnificaciones de 10x-500x  y software image J,  a las muestras se le 

realizaron mediciones en tres áreas de contacto del implante al abutment las cuales fuerón: 

1.El hombro del implante, que es el área de contacto externa del cuello del implante  con el 

abutment,  la longitud de contacto entre el abutment y el hombro del implante y se 

relacionaron estas dos medidas.2. La conexión interna, la cual es el a área del contacto del 

abutment con la conexión interna del implante, la longitud del área de contacto de la conexión 

interna. 3. La rosca del tornillo de fijación, que es el área de contacto entre el tornillo y las 

roscas internas del implante, el número de roscas del tornillo en contacto con el área de 

apretamiento del implante. Después de las mediciones realizadas en cada grupo se 

compararón (Mattheos N, 2017). 

En otra investigación se realizó un análisis y un examen estructural de la rosca de tornillo o 

el aflojamiento del pilar en comparación con roscas de tornillo o pilar sin aflojamiento. El 

aflojamiento de las roscas de tornillo se comparó con la rosca sin aflojamiento de tres 

sistemas de implantes diferentes; Branemark (Nobel Biocare, Gotemburgo, Suecia), Implant 

Innovations (Riverside Drive, Palm Beach Gardens, FL, EE.UU.) y Restore (Lifecore 

Biomedical, Chaska, Minnesota, EE.UU.). Se observaron un total de 16 aflojamientos de rosca 

(Grupo I) (5 Branemark, 4 Implant Innovation y 7 Restore), 10 roscas de tornillo sin 

aflojamiento (Grupo II) y 6 roscas recibidas por el fabricante (sin usar) Grupo III) como 

control (2 Branemark, 2 Implant Innovation y 2 Restore). Los tornillos de pilar sueltos fueron 

recuperados y analizados bajo SEM. Muchas alteraciones y deformaciones estaban presentes 



15 

 

en las concavidades y convexidades de las roscas del grupo I. No se observaron alteraciones 

o deformaciones macroscópicas en los grupos II y III. Se observó una diferencia estadística 

de la presencia de microfisuras entre las roscas con un aflojamiento del pilar y roscas de 

tornillo sin aflojamiento del pilar Las roscas de tornillo se analizaron bajo SEM y para 

fractografia. El análisis realizado fue una caracterización de la microestructura y la iniciación 

de la grieta de fatiga en el nivel de rosca de los tornillos de los 3 grupos. La hipótesis en 

cuestión supuso que había diferencias entre los grupos. 

La evaluación de las roscas del tornillo se realizó bajo SEM después del lavado [todas las 

muestras recuperadas se lavaron previamente] durante 5 min en acetona usando un equipo 

de limpieza por ultrasonidos. La superficie de las roscas de tornillo se evaluó con un 

microscopio electrónico de barrido Leo 435 VP (LEO, Cambridge, UK). Ambas muestras 

utilizadas fueron embebidas en una resina de glicolmetacrilato (Technovit 7200 VLC, Kulzer, 

Wehrheim, Alemania). Después de la polimerización, los especímenes se seccionaron 

longitudinalmente a lo largo del eje principal del tornillo con un disco de diamante de alta 

precisión a aproximadamente 150 μm y se trituraron hasta aproximadamente 30 μm con un 

sistema de precisión automatico (Assing, Roma, Italia). Se obtuvieron tres cortes para cada 

tornillo. Las láminas se grabaron mediante una disolución en etanol de HF al 0,5% en agua 

destilada a 20ºC y se observaron en microscopía óptica (Laborlux S, Leitz, Wetzlar, 

Alemania). El número de grietas y el estado de las roscas de los 3 grupos de muestras se 

examinaron bajo un microscopio de luz (Laborlux S, Leitz, Wetzlar, Alemania) conectado a 

una cámara de vídeo de alta resolución (3CCD, JVC KY-F55B) e interconectado a un monitor 

y PC (Intel Pentium III 1200 MMX). 

Este sistema óptico se asoció con una almohadilla de digitalización (Matrix Vision GmbH) y 

un paquete de software con capacidades de captura de imágenes (Image-Pro Plus 4.5, Media 

Cybernetics Inc., Immagini & Computer Snc Milano, Italia). Las mismas muestras fueron 

pulverizadas con oro (Emitech K 550 Emitech Ltd. Ashford, Kent, Reino Unido) y evaluadas 

bajo microscopía electrónica de barrido (SEM LEO 435vp Cambridge, Reino Unido) para 

evaluar la microestructura del metal y las grietas.  (Scarano et al., 2007) 

En otro estudio, se evaluó dos implantes dentales del mismo tipo casa comercial con diferente 

tratamiento, uno microarenado y otro grabado ácido en dos tipos de conexiones, hexágono 
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interno y hexágono externo, fueron examinados por microscopio electrónico de barrido con 

diferentes aumentos. El implante TTI (Torque Type® Implant I), con un implante con 

conexión hexagonal interna e implante TTX (Torque Type® Implant X), con una conexión 

hexagonal con conexión externa. 

La macroestructura del diseño geométrico de los diferentes segmentos de la estructura, las 

características de la conexión protésica y la microestructura de la superficie del implante se 

analizaron mediante Scanning Electron Microscopio (Zeizz EVO-50, Cambridge, Reino 

Unido). La distancia de trabajo mantenida entre 9 y 12 mm, de acuerdo con los diferentes 

requisitos y tipos de muestras (Tetè et al., 2012). 

Tabla 1. Artículos que validan medidas tomadas en el estudio 

Autores Artículos Medidas Método 

Binon et al., 
1995 

Evaluation of Machining 
Accuracy and 
Consistency of Selected 
Implants, Standard 
Abutments, and 
Laboratory Analogs 

Implante hexagono externo: diámetro 
coronal (cabeza); diámetro del cuerpo 
(ancho); altura del hexagono, y ancho de 
extensión hexagonal de plano a plano para 
las tres superficies opuestas. 

- En abutments: ancho y longitud del cuello. 

Micrómetro digital y 
microscopio micrométrico 

Jaarda el 
at., 1995 

Geometric comparison of 
five interchangeable 
implant prosthetic 
retaining screws 

En tornillos de fijación: 
Diámetro de la cabeza del tornillo; longitud 
del tornillo; paso de rosca; diámetro mayor;  
diámetro del cuello;  longitud del cuello;  
ancho de la cresta; y  ancho de valle. 

Scanning electron 
microscopy  (SEM) 

 
Lang et al., 
2003 

Evaluation of the 
Precision of Fit 
Between the Procera 
Custom Abutment and 
Various Implant 
Systems  
 

Diámetro de la cabeza del tornillo, el 
diámetro del vástago del tornillo y el 
diámetro de la porción roscada del tornillo, 
roscas del tornillo 
Altura de hexagono externo del implante 
Diametro interno de implantes 

Medidores de avance y 
desactivación (para 
verificar las dimensiones 
del tornillo y del diámetro 
interior del tornillo) 
Calibrador electrónico 

A. Scarano 
et al., 2007 

SEM and fractography 
analysis of screw thread 
loosening in dental 
implants. 
 

Se observaron las roscas de los tornillos 
después de ser sometidos a cargas cíclicas. 

Scanning electron 
microscopy  (SEM) 

Guzaitis et 
al.,2011 

Effect of repeat screw 
joint closing and opening 
cycles on implant 
prosthetic screw reverse 
torque and implant and 
screw thread 
morphology 

Realizaron el análisis de la superficie de 
implantes y tornillos de fijación (paso de 
rosca) antes y después de ser sometidos 
ante torque reverso. 

Scanning electron 
microscopy  (SEM) 

A. Scarano 
et al., 2011 

Analysis and structural 
examination of screw 
loosening in oral 
implants 

Se hace el análisis de microtextura de la 
superficie de los tornillos de fijación de los 
abutments en diferente sistemas de 
implantes  

Scanning electron 
microscopy  (SEM) 
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Autores Artículos Medidas Método 

Malaguti et 
al.,2011 

Dimensional Tolerances 
and Assembly Accurary 
of Dental  Implants and 
machined versus cast-on 
abutments 

SE evaluó el ancho del hexágono de un lado 
del hexágono y del lado opuesto. 

Scanning electron 
microscopy  (SEM) 

Orsini et 
al.,2012 

Dental implant thread 
pitch and its influence on 
the osseointegration 
process: an in vivo 
comparison study. 

Evaluaron el paso de rosca de dos 
diferentes sistemas de implantes. 

Scanning electron 
microscopy  (SEM) 

Tete et al., 
2012 

Macroscopic and 
microscopic evaluation of 
a new implant design 
supporting immediately 
loaded full arch 
rehabilitation 

En implantes dentales: Longitud del cuello, 
Conicidad del cuello, Paso de rosca del 
implante, Profundidad de roscas, Ancho de 
rosca, Distancia rosca-rosca, Distancia Pico-
Pico 

Scanning electron 
microscopy  (SEM) 

Ryu et 
al.,2014 

The influence of thread 
geometry on implant 
osseointegration under 
immediate loading: a 
literature review 

Indica las diferentes partes y definiciones 
de un implante: micro roscas, paso de rosca, 
profundidad de las roscas y ancho de la 
cresta.  

Scanning electron 
microscopy  (SEM) 

Arshad M. 
et al.,2018 

Effect of Repeated Screw 
Joint Closing and 
Opening Cycles and Cyclic 
Loading on Abutment 
Screw Removal Torque 
and Screw Thread 
Morphology: Scanning 
Electron Microscopy 
Evaluation 

SE evaluó las roscas de tornillos de fijación 
ante cargas cíclicas y los compararon con 
otros no usados. 

Scanning electron 
microscopy  (SEM) 
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3.PLANTEAMIENTO DEL PROBLEMA 

DESCRIPCIÓN DEL PROBLEMA 

Los implantes dentales son un conjunto de múltiples componentes, están conformados por 

el cuerpo del implante, el abutment, y la parte protésica. En los diseños convencionales de 

dos piezas el implante y el abutment se mantienen unidos por medio de un tornillo de fijación, 

quedando un microgap entre la conexión de estos. Varios estudios han indicado que una vez 

ocurre la oseointegración, el aflojamiento del tornillo y la reabsorción de la cresta ósea, son 

frecuentemente  las complicaciones más comunes asociadas a los implantes dentales y en 

este tipo de fallas se han reportado relaciones directas con el tipo de conexión; dado que al 

enfrentarse el implante y el abutment a cargas repetitivas con la presencia de un microgap en 

su interface se produce perdida de la precarga provocando el aflojamiento del tornillo, 

afectando el hueso de la cresta ósea alrededor de la conexión. Desde la percepción bilógica, 

el microgap presente en la conexión actúa como un nicho bacteriano, favoreciendo procesos 

inflamatorios en los tejidos peri-implantarios generando finalmente reabsorción ósea.  (Yao 

et al., 2014) Resaltando la importancia de una conexión implante-abutment estable y fiable, 

siendo necesaria para la longevidad del implante en boca. 

Actualmente, las casas fabricantes han propuesto el uso de conexiones implante- abutment 

que permitan una unión íntima y alta estabilidad evitando así la presencia de micro 

movimientos y futuros fracasos biológicos y mecánicos, las cuales permiten un acoplamiento 

mutuo y un contacto íntimo disminuyendo la presencia de microgap en la interfase 

generando una mejor distribución de fuerzas y tensiones. (Yao et al., 2014) 

Existen diferentes tipos de conexiones una de ellas es la conexión tipo hexágono interno 

activo; es la conexión en donde hay presencia de una característica geométrica en forma de 

hexágono que se extiende por debajo y por dentro de la superficie coronal del implante (5,5 

mm), y que se caracteriza por mantener una especie de ajuste por fricción, donde no existe 

espacio entre los componentes de acoplamiento y las partes son literalmente forzadas entre 

sí. (Binon., 2000).  

Actualmente se están implementando otras opciones de fabricación de abutments utilizando 

sistemas de diseño y fabricación asistida por computador (CAD / CAM) (Hamilton et al., 
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2013); los cuales generan abutments capaces de producir un ajuste, asentamiento, contorno 

anatómico y corrección de angulaciones comparable con los abutments prefabricados y a la 

medida que se requieren (Ji-Man P et al., 2014).   

Hay poca evidencia que evalué la tolerancia de los tornillos de fijación y abutments 

prefabricados y personalizados. Paek et al., [2016] sugieren que tanto el sistema 

personalizado como el prefabricado presentan buena estabilidad y son similares 

dimensionalmente; por el contrario, Mattheos et al., [2016] sugieren que los pilares 

personalizados pueden presentar diferencias morfológicas críticas con respecto a los 

prefabricados. En efecto las diferencias en la geometría transversal producen grandes 

discrepancias en las áreas de contacto en términos de cantidad como de calidad, lo que puede 

traer implicaciones para la estabilidad a largo plazo de la prótesis. (Mattheos et al., 2016).  Es 

evidente que aún no existe información suficiente que resuelva estas controversias, además 

no existe literatura que evalué las diferencias morfológicas entre abutments prefabricados 

con sus homólogos de hexagono interno activo, los cuales tienen una amplia demanda; Por 

tal razon el proposito de este estudio fue evaluar la tolerancia de los tornillos de fijación y 

hexagono interno activo en abutments prefabricados y personalizados,  para lo cual se 

utilizaron muestras de abutments y tornillos prefabricados con sus homologos 

personalizados. Las imágenes se obtuvieron con microscopio electronico de barrido a 

diferentes magnificaciones y se tomaron las medidas mediante un software y finalmente se 

compararon entre si. 

PREGUNTA DE INVESTIGACIÓN 

¿Cuál es la tolerancia de los tornillos de fijación y abutments de hexágono interno activo 

prefabricados y personalizados?  
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4.JUSTIFICACIÓN 

El comportamiento biomécanico de los componentes protesicos  están diseñados para 

mantener estable la conexión implante-abutment, soportar las cargas ejercidas sobre el 

sistema de implantes, disminuir la  perdida de la precarga y  el aflojamiento del tornillo de 

fijación. (Junqueira et al., 2013), El abutment se encuentra fijado al implante mediante un 

tornillo de fijación el cual sera sometido a diferentes fuerzas verticales, horizontales y 

laterales que pueden provocar fallas mecánicas al presentarse en repetidas ocasiones 

durante las cargas oclusales (Kim et al., 2009).  

Los implantes presentan diferentes tipos de conexión con el fin de reducir la presencia de 

micromovimientos en la interfase abutment- implante, siendo una de ellas el Hexágono 

interno activo definido como la conexión de la interfase en la que existe una característica 

geométrica en forma de hexágono que se extiende por debajo y por dentro de la superficie 

coronal del implante, y se caracteriza porque presenta una unión de ajuste por “fricción”, 

donde no existe espacio entre los componentes de acoplamiento y las partes son literalmente 

forzadas entre sí; eliminando virtualmente el micromovimiento del abutment  asociado 

directamente con el aflojamiento del tornillo. (Binon., 2000, Junqueira et al., 2013) 

En la actualidad se fabrican abutments personalizados por sistemas CAD CAM los cuales 

ofrecen ventajas en cuanto a la corrección de la angulación; por lo que existe una amplia 

demanda de este tipo de aditamentos. Los abutments personalizados pueden presentar 

importantes diferencias morfológicas en relacion con los abutments prefabricados dando 

lugar a grandes diferencias en las áreas de contacto, tanto en términos de calidad como de 

cantidad evidenciandose un mal ajuste del abutment que conduce a un aumento de stress y 

tensión en la parte interna del implante, concluyendo que el contacto interno y externo entre 

el abutment y el implante apropiado es crucial para el éxito protesico a largo plazo y la 

prevención de complicaciones; por lo tanto, es importante comparar la tolerancia de tornillos 

de fijación y de abutments personalizados y prefabricados con sistemas de conexión tipo 

hexagono interno activo. (Mattheos  et al., 2016) 
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5.OBJETIVOS  

OBJETIVO GENERAL  

Evaluar la tolerancia de los tornillos de fijación y hexágono interno activo en abutments 

prefabricados y personalizados. 

OBJETIVOS ESPECÍFICOS  

 Determinar las características dimensionales (diámetro de la cabeza del tornillo, 

longitud del tornillo, longitud de paso de rosca, diámetro mayor, diámetro del cuello, 

longitud de cuello, ancho de la cresta, ancho del valle y ángulo de rosca) de los tornillos 

de fijación de los sistemas de abutment personalizado y el prefabricado. 

 Determinar las características dimensionales (diámetro, perímetro del hexágono, y 

longitud de cada lado del hexágono) de sistemas de abutment de hexágono interno 

activo personalizado y prefabricado. 

 Comparar las características dimensionales (diámetro de la cabeza del tornillo, 

longitud del tornillo, longitud de paso de rosca, diámetro mayor, diámetro del cuello, 

longitud de cuello, ancho de la cresta, ancho del valle y ángulo de rosca) entre los 

tornillos de fijación de los sistemas de abutment personalizado y el prefabricado. 

 Comparar las características dimensionales (diámetro, perímetro del hexágono, y 

longitud de cada lado del hexágono) de sistemas de abutment de hexágono interno 

activo personalizado y prefabricado. 
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SISTEMATIZACIÓN DE VARIABLES  

VARIABLES INDEPENDIENTES (X) 

SISTEMA DE ABUTMENT: Es el componente que se coloca o incorpora en la parte coronal de 

un implante dental oseointegrado, para conectar este con el o los dientes a reemplazar, los 

cuales pueden tener una fijación cementada o atornillada sobre el abutment. 

HEXAGONO INTERNO ACTIVO: ES la conexión en donde hay presencia de una característica 

geométrica en forma de hexagono que se extiende por debajo y por dentro de la superficie 

coronal del implante y se caracteriza por un acoplamiento de ajuste por fricción, donde no 

existe espacio entre los componentes y las partes son literalmente forzadas entre sí (Binon., 

2000) 

FABRICACIÓN DE SISTEMAS DE ABUTMENTS 

PREFABRICADO (Casa Comercial) Sistema realizado por la casa comercial con medidas 

estándar que permite exactitud en la conexión con el abutment. 

PERSONALIZADOS (Customized / customised): Sistema realizado por laboratorios en donde 

por medio de un software con librerías de conexiones se pueden fabricar abutments de varios 

sistemas de implantes con técnica CAD CAM. (Catalogo Phibo). 

VARIABLES DEPENDIENTES (Y)  

TOLERANCIA: Es la diferencia entre la medida máxima y mínima o dimensión de la zona 

dentro de la cual ha de quedar la medida practica para que la pieza sea dada como válida. 

(Lara et al., 2013). 

TOLERANCIA DE TORNILLO DE FIJACIÓN: Es la diferencia entre la medida máxima y 

mínima o dimensión de la zona dentro de la cual ha de quedar la medida practica para que la 

pieza sea dada como válida de cualquier dispositivo que se utiliza para posicionar el pilar de 

implante dental sobre el cuerpo del implante dental. (Glossary of implant terms., 2017). 

Medida en términos de: 

- Filete: prismas en forma de hélice que se enrollan alrededor y a lo largo de un cilindro 

que se llama núcleo. 
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- Diámetro de la cabeza del tornillo: Es la superficie de apoyo adecuada para la herramienta 

de apriete de forma tal que se pueda alcanzar la fuerza necesaria sin que esta se rompa o 

deforme. Es la porción de mayor diámetro del tornillo. 

- Longitud del tornillo: medida que se toma desde la zona donde termina la cabeza del 

tornillo hasta el final de la rosca  

- Longitud de paso de rosca: distancia entre las crestas de dos filetes sucesivos. Es la 

distancia desde un punto sobre un filete hasta el punto correspondiente sobre el filete 

adyacente. 

- Diámetro mayor: Grosor del tornillo medido en la zona de la rosca. 

- Diámetro del cuello: Grosor en la zona no roscada del tornillo.  

- Longitud de cuello: Distancia que está comprendida por la porción no roscada del tornillo. 

- Ancho de la cresta: Es el diámetro exterior o mayor del filete. Grosor de la parte más externa 

del filete.  

- Ancho del valle: Es el diámetro interior o menor del filete.  

- Angulo de rosca: ángulo formado por dos filetes contiguos. 

TOLERANCIA DE HEXÁGONO: Es un polígono convexo con seis lados iguales y seis ángulos 

iguales donde sus ángulos internos son congruentes midiendo 120° y sus ángulos externos 

miden 60°. Medida en términos de: 

- Diámetro: Equivale a las áreas de seis triángulos equiláteros que se obtienen al unir el centro 

con los seis vértices 

- Perímetro: Es seis veces la longitud de su lado 

- Longitud de cada lado del hexágono: Se mide desde un vértice a otro. 

- Altura del Hexágono: Longitud desde parte externa del cuello del hexágono del abutment 

hasta la parte interna de la plataforma protésica. 
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6. METODOLOGIA DEL PROYECTO 

6.1 Tipo de estudio 

Estudio descriptivo con asociación de variables. 

6.2 Población y muestra 

Población: Se utilizaron los sistemas de abutments de hexagono interno activo -  

prefabricado y personalizados. 

Muestra:  

Se utilizó una muestra no probabilística de 10 abutments (hexágono y tornillo de fijación) por 

cada uno de los sistemas evaluados; prefabricados y personalizados (ver tabla 3)  

Tabla 2. Distribución de los grupos de estudio  

Grupo N Tipo de abutment Marca 

Control 

10 Abutment de hexágono Interno activo (Friction fit) de 1.5 mm de 
profundidad con plataforma 3.5 mm en titanio, anti rotacional con su 
respectivo tornillo de fijación en titanio 

HLA3/3, ZIMMERBIOMET, 
Warsaw, Indiana, USA) 

Estudio  

10 
 

Abutment de hexágono Interno activo de plataforma 3.5 mm  personalizado 
con conexión en titanio(Ti- Base) (Ti6Al4V), antirotacional con su respectivo 
tornillo de fijacion en titanio. 

zfx11001154, ZFX, Dachau, 
Alemania) 

 

Criterios de inclusión y exclusión 

Criterios de inclusión  

Abutments de hexágono Interno Activo Prefabricados de plataforma 3.5mm de diámetro 

que tenga su homologo personalizado. 

https://www.google.com/search?client=safari&rls=en&q=Warsaw+Indiana&stick=H4sIAAAAAAAAAOPgE-LUz9U3sKxIyy1X4gAxi_MMcrW0spOt9POL0hPzMqsSSzLz81A4VhmpiSmFpYlFJalFxQDm7ciGQwAAAA&sa=X&ved=0ahUKEwi5pbri5s7ZAhUptlkKHWbYAmcQmxMIygEoATAO
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Criterios de exclusión  

Abutments de hexágono Interno Activo prefabricados o personalizados de plataforma 3.5mm 

de diámetro que presentaron durante inspección con microscopio óptico a 80X los siguientes 

defectos de fabricación tanto en el tornillo de fijación como en el hexágono del abutment: 

 Ángulos indefinidos entre los lados del hexágono  

 Grietas en crestas y valles 

 Rotura del cuello del tornillo. 

 Doblez en el Tornillo 

 Corrosión sobre la superficie del tornillo de fijación y/o hexágono del abutment.   

6.3 Materiales y métodos  

EVALUACIÓN DE LAS DIMENSIONES 

Preparación de la muestra  

Se tomaron 10 sistemas de abutments prefabricados HEXAGONO INTERNO ACTIVO de cada 

uno de los sistemas seleccionados y para cada uno de los sistemas se fabrico su homologo. 

- Hexágono interno activo prefabricado: Marca, ZimmerBiomet Referencia, HLA3/3, 

Plataforma 3.5 mm de diametro. 

- Hexágono interno activo personalizado: Marca: CAD CAM ZFX, Referencia: 

ZFX11001154, Plataforma de 3.5 mm de diámetro. 

Para obtener los abutments homólogos, se solicitó al laboratorio ZFX el cual cuenta con el 

sistema CAD- CAM y la librería respectiva para la fabricación de los abutments de acuerdo a 

la referencia seleccionada. 

Se verificó que cumplieran con los criterios de inclusión y exclusión descritos anteriormente. 

Obtención de imágenes 

La obtención de las imágenes tanto de los tornillos de fijación como de los hexágonos de los 

abutments de conexión interna activa; prefabricados y personalizados se realizó utilizando 
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un Microscopio electrónico de barrido (modelo JSM-6490LV, JEOL LTD., Boston, 

Massachusetts, USA.) 

Sobre un portaobjetos metálico de 7 cm de diámetro, se fijaron las muestras (tornillos – 

hexágonos) con cinta adhesiva conductiva de carbono de doble cara de 8 mm de ancho 

(Carbon conductive tapes, double coated, 8 mmWx20mm L, TED PELLA, INC., Altadena, 

California, USA) para obtener el asentamiento total de la muestra sobre el portaobjetos los 

tornillos de fijación se ubicaron de forma horizontal donde solo la cabeza del tornillo estuvo 

en contacto con la cinta adhesiva (Carbon conductive tapes, double coated, 8 mmWx20mm 

L, TED PELLA, INC., Altadena, California, USA) y los abutments se posicionaron de dos 

maneras; vertical y horizontal; en dos momentos diferentes. Las muestras fueron 

enumeradas sobre el portaobjetos con un micropunta negro (Sharpie,Worcester, 

Massachusetts, USA) ,posteriormente se ubicó el portaobjetos dentro del microscopio 

(modelo JSM-6490LV, JEOL LTD., Boston, Massachusetts, USA.) en alto vacío por 5 minutos 

La unidad óptica-electrónica que genera el haz se desplazó sobre las muestras y mediante un 

sistema de registro fotográfico se capturaron 4 imágenes para el tornillo de fijación (tornillo 

completo, cabeza del tornillo, cuello y vástago) y 2 imágenes para el hexágono del abutment 

(vista horizontal y vista vertical), cada una a diferente magnificación y obtenidas en formato 

TIF (Ver tabla 4). 

Tabla 3. Magnificación de las imágenes para cada variable analizada. 

 

 

 

IMÁGENES AUMENTO  ANGULACIÓN 

TORNILLOS DE FIJACIÓN  

Tornillo completo 13X 0° 

Cabeza 30X 0° 
Cuello 30X 0° 
Vástago 37X 0° 

HEXÁGONOS DE LOS 
ABUTMENTS 

Altura del hexágono 
(vista vertical) 

30X 0° 

Hexágono             (vista 
horizontal) 

35X 7° 

Diametro máximo y 
mínimo hexagonal (vista 
horizontal) 

19X 0° 
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Toma de mediciones  

Una vez capturadas todas las imágenes de las muestras se registró el valor métrico en micras 

(µ) y en grados (°) de forma individual por cada una teniendo en cuenta todas las variables 

medidas; tanto en los tornillos de fijación como en los abutment prefabricados y 

personalizados. La evaluación dimensional de las imágenes fue realizada a través del 

software (Image Jfiji, National Institutes of Health, Bethesda, Maryland, USA) en donde se 

insertaron las imágenes en formato TIF mediante las opciones File>Open; se realizó la 

calibración de la escala métrica encontrada en la parte inferior de la imagen ( Analyze > set 

scale,  Know distance: 500, Unit of length: um; y se marcó Global) para iniciar con la toma de 

mediciones, estos valores métricos fueron arrojados por el software para determinar la 

medida especifica por muestra tanto en sistemas personalizados como prefabricados. 

(Mattheos et al., 2016, Hamilton et al., 2003, Martin et al., 2016, Scarano et al., 2016, Khraisat 

et al., 2002, Mattheos., 2017, Scarano et al., 2007, Tetè et al., 2012). 

TORNILLO DE FIJACIÓN 

1. Longitud tornillo completo: Distancia existente desde el punto medial externo de la cabeza 

del tornillo (a) hasta el punto medial del borde externo del vástago del tornillo (b), reportada 

en micras (ver figura 1). Sobre la imagen se posiciono un rectángulo en los puntos 

mencionados y mediante la opción Analyze>Plop profile se determinó la ubicación en cada 

punto. Finalmente se obtuvo el resultado del ancho del rectángulo mediante la opción 

Analyze> Measure. 

2. Longitud tornillo parte activa: Distancia existente desde el punto medial externo del cuello 

del tornillo (a) hasta el punto medial del borde externo del vástago del tornillo (b), reportada 

en micras (ver figura 2). Sobre la imagen se posiciono un rectángulo en los puntos 

mencionados y mediante la opción Analyze>Plop profile se determinó la ubicación en cada 

punto. Finalmente se obtuvo el resultado del ancho del rectángulo mediante la opción 

Analyze> Measure. 

3. Longitud de la cabeza del tornillo: Distancia existente desde un punto medial del borde 

superior de la cabeza del tornillo (a) hasta el punto medial del borde inferior del cabeza del 

tornillo (b); donde inicia el cuello del tornillo, reportada en micras (ver figura 3). Sobre la 
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imagen se posiciono un rectángulo en los puntos mencionados y mediante la opción 

Analyze>Plop profile se determinó la ubicación en cada punto. Finalmente se obtuvo el 

resultado del ancho del rectángulo mediante la opción Analyze> Measure. 

4. Diámetro de la cabeza del tornillo: Distancia existente desde un punto medial lateral de la 

cabeza del tornillo (a) al borde medial opuesto (b), reportada en micras (ver figura 4). Sobre 

la imagen se posiciono un rectángulo en los puntos mencionados y mediante la opción 

Analyze>Plop profile se determinó la ubicación en cada punto. Finalmente se obtuvo el 

resultado de la altura del rectángulo mediante la opción Analyze> Measure. 

5. Longitud de cuello: Distancia existente desde un punto medial del borde superior del cuello 

del tornillo (a) hasta el punto medial del borde inferior del cuello del tornillo (b); donde inicia 

la primera rosca, reportada en micras (ver figura 5). Sobre la imagen se posiciono un 

rectángulo en los puntos mencionados y mediante la opción Analyze>Plop profile se 

determinó la ubicación en cada punto. Finalmente se obtuvo el resultado del ancho del 

rectángulo mediante la opción Analyze> Measure. 

6. Longitud de cuello del tornillo: Distancia existente desde un punto medial del borde 

superior del cuello del tornillo (a) hasta el punto medial del borde inferior del cuello del 

tornillo (b); donde inicia la primera rosca, reportada en micras (ver figura 6). Sobre la imagen 

se posiciono un rectángulo en los puntos mencionados y mediante la opción Analyze>Plop 

profile se determinó la ubicación en cada punto. Finalmente se obtuvo el resultado del ancho 

del rectángulo mediante la opción Analyze> Measure. 

7. Diámetro del cuello: Distancia existente desde un punto medial lateral del cuello del tornillo 

(a), al borde medial opuesto (b), reportada en micras (ver figura 7) Sobre la imagen se 

posiciono un rectángulo en los puntos mencionados y mediante la opción Analyze>Plop 

profile se determinó la ubicación en cada punto. Finalmente se obtuvo el resultado de la 

altura del rectángulo mediante la opción Analyze> Measure. 

8. Diámetro mayor del vástago: Distancia existente entre dos puntos mediales sobre todo el 

lomo de la tercera cresta, reportado en micras (Ver figura 8). Sobre la imagen se posiciono 

una línea en los puntos mencionados y mediante la opción Analyze>Plop profile se determinó 
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la ubicación en cada punto. Finalmente se obtuvo el resultado del ancho de la línea mediante 

la opción Analyze> Measure. 

9. Ancho de la cresta: Distancia existente de filete (a) a filete (b) en uno de los lados del vástago 

ubicado en la tercera y quinta cresta, reportado en micras (Ver figura 9). Sobre la imagen se 

posiciono una línea en los puntos mencionados y mediante la opción Analyze>Plop profile se 

determinó la ubicación en cada punto. Finalmente se obtuvo el resultado del ancho de la línea 

mediante la opción Analyze> Measure, este procedimiento se hizo dos veces para determinar 

la medida del ancho de la cresta tercera y la quinta. 

10. Longitud de paso de rosca: Distancia existente desde el filete de la tercera cresta (a), al filete 

de la cuarta cresta (b), reportada en micras (ver figura 10). Mediante las opciones 

Analyze>Plop Profile se logró la ubicación más precisa desde el inicio de cada filete. Se midió 

mediante un rectángulo que al arrojar la medida del ancho del rectángulo permitió conocer 

la distancia existente de punto a punto; para conocer el resultado se marcó la opción 

Analyze> Measure 

11. Ángulos de rosca: Angulo formado por dos filetes contiguos, en donde el vertice está ubicado 

en la tercera y quinta cresta, reportada en grados (ver figura 11). Mediante la opción del 

programa que permite obtener el resultado de la medida de los angulos (<) se ubicaron dos 

líneas sobre las superficies rectas que formaron los angulos de las roscas a analizar y se 

obtuvo el resultado por medio de la opción Analyze> Measure 

12. Ángulos de valle: Angulo formado por dos filetes contiguos, entre la tercera y cuarta cresta 

y la quinta y sexta cresta, en donde el vertice está ubicado en el valle, reportada en grados 

(ver figura 12). Mediante la opción del programa que permite obtener el resultado de la 

medida de los angulos (<) se ubicaron dos líneas sobre las superficies rectas que formaron 

los angulos de las roscas a analizar y se obtuvo el resultado por medio de la opción Analyze> 

Measure 

13. Angulo de asentamiento: Angulo formdo por la union de la cabeza del tornillo y el vastago 

del tornillo, reportada en grados (Ver figura 13).  Mediante la opción del programa que 

permite obtener el resultado de la medida de los angulos (<) se ubicaron dos líneas sobre las 
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superficies rectas que forman el ángulo a analizar y se obtuvo el resultado por medio de la 

opción Analyze> Measure. 

 

Figura 1 
(1) Longitud tornillo completo: distancia entre a y b 

 

 

Figura 2 
(2) Longitud tornillo parte activa: distancia entre a y b 

 

 

Figura 3 
(3) Longitud cabeza del tornillo: distancia entre a y b. 
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Figura 4.  
(4) Diámetro cabeza del tornillo: distancia entre a y b. 

 

 

Figura 5 
(5) Longitud del cuello del tornillo: distancia entre a y b. 

 

 

Figura 6 
 (6) Diámetro del cuello del tornillo: distancia entre a y b 

 



32 

 

 

Figura 7 
(7) Diámetro mayor del vástago: distancia entre a y b. 

 

 

Figura 8 
(8) Ancho de la tercera y quinta cresta del vástago: distancia entre a y b. 

 
 

 
Figura 9 

 (9) Ancho del tercer y quinto valle del vástago: distancia entre a y b 
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Figura 10 

(10) Longitud de paso de rosca: distancia entre a y b. 
 

 

Figura 11 
(11) Ángulo de rosca 

 

 
Figura 12 

(12) Ángulo del valle  
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Figura 13 

(13) Ángulo de asentamiento 

 
HEXAGONO DEL ABUTMENT 

1. Altura del Hexágono: Distancia existente desde parte media de la superficie externa del 

cuello del hexágono del abutment (a), hasta la parte media de la plataforma protésica (b), 

reportado en micras (ver figura 14). 

2. Perímetro: Sumatoria de las longitudes de los seis lados mayores (L1+L3+L5+L7+L9+L11) 

y los seis lados menores (L2+L4+L6+L8+L10+L12), reportado en micras (ver figura 15). 

3. Ancho de extensión hexagonal: Distancia existente desde el punto medio del lado 9 L9 (a), 

al lado opuesto (L3) (b), pasando por el centro del hexágono (ver figura 16). 

4. Longitud del lado mayor del hexágono: Distancia existente en uno de los lados mayores de 

la imagen, de vértice (a) a vértice (b), reportado en micras (ver figura 17). 

5. Longitud del lado menor del hexágono: Distancia existente en uno de los lados menores 

de la imagen, de vértice (a) a vértice (b), reportado en micras (ver figura 18). 

6. Diámetro máximo hexagonal: Distancia existente desde la parte externa del diámetro 

máximo (a), a su punto opuesto (b), pasando por el centro del hexágono (ver figura 19). 

7. Diámetro menor hexagonal: Distancia existente desde la parte interna del hexágono desde 

un punto (a), a su punto opuesto (b), pasando por el centro del hexágono (ver figura 20). 



35 

 

 
Figura 14 

(1) Altura del hexágono: distancia entre a y b. 

 

 
Figura 15 

(2) Perímetro: sumatoria de la longitud de todos los lados:  
(3) L1+L2+L3+L4+L5+L6+L7+L8+L10+L11+L12 

 
Figura 16 

(4) Ancho de extensión hexagonal: distancia entre a y b 
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Figura 17 

(4) Longitud del lado mayor del hexágono: distancia entre a y b. 

 
Figura 18 

(5) Longitud del lado menor del hexágono: distancia entre a y b. 
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Figura 19 

(6) Diámetro máximo hexagonal: distancia entre a y b. 

 
Figura 20 

(7) Diámetro menor hexagonal: distancia entre a y b. 
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Calibración de Examinadores 

Para la realización de las mediciones se llevó a cabo una fase de entrenamiento previo y 

calibración de examinadores en el uso del software ImageJfiyi.  Para el entrenamiento de los 

examinadores se realizó un entrenamiento inicial donde se utilizaron 2 y 6 imágenes de 

tornillos y abutments. Teniendo una base inicial de mediciones, se realizó la calibración 

inicial donde se utilizaron 5 imágenes diferentes de tornillos y abutments – en posición 

horizontal y vertical en las que se midieron todas las variables correspondientes al 

tornillo: longitud tornillo completo, longitud tornillo parte activa, longitud de la cabeza del 

tornillo, diámetro de la cabeza del tornillo, longitud de cuello, longitud de cuello del tornillo, 

diámetro del cuello, diámetro mayor del vástago, ancho de la cresta, longitud de paso de 

rosca, ángulos de rosca, ángulos de valle, ángulo de asentamiento y para las variables 

correspondientes a los hexágonos de los abutments: altura del Hexágono, perímetro, ancho 

de extensión hexagonal, longitud del lado mayor del hexágono, longitud del lado menor del 

hexágono, diámetro máximo hexagonal, diámetro menor hexagonal. Las mediciones 

dimensionales fueron tomadas en micras y las de los ángulos en grados. 

Calibración Interexaminadores: Se compararon las mediciones realizadas sobre las 

imágenes por el examinador estándar con las realizadas por los 5 examinadores. Los datos 

se analizaron utilizando el coeficiente de correlación intraclase (ICC) donde se obtuvo un 

valor de [0.965-0.969] y se aceptó un valor mínimo de 0.8 para cada examinador. 

Calibración Intraexaminadores: Una vez se establecida la calibración interexaminador con 

los examinadores que lograron una buena calibración, se realizó una calibración 

intraexaminadores donde se compararon las mediciones realizadas en 3 sesiones diferentes 

sobre las imágenes de los mismos 5 tornillos y 5 abutments, codificados a ciego de manera 

diferente para cada una de las sesiones. Los datos se analizaron utilizando el coeficiente de 

correlación intraclase (ICC) donde se obtuvo un valor de [0,953 – 0,999] y se aceptó un valor 

mínimo de 0.8 para cada examinador. 
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6.4. HIPÓTESIS 

HIPÓTESIS NULA:  

La tolerancia en los tornillos de fijación y en el hexágono del abutment del sistema de 

conexión hexágono interno activo fue similar entre abutments prefabricados y 

personalizados. 

 

6.5 Plan de tabulación y análisis 

Todos los datos de los sujetos evaluados se registraron en una base de Excel y se analizaron 

mediante el programa SPSS Statistics 22.0.0. y Epidat 4.2. 

Se realizó análisis descriptivo de los datos a través de promedios y desviaciones estándar por 

cada una de las variables del tornillo de fijación y del hexágono del abutment y se evaluó la 

distribución de los datos por medio de prueba Shapiro-Wilk. Para la comparación de los 

grupos según cada una de las variables se utilizó prueba de t test para las variables del 

tornillo de fijación: ancho de la tercera y quinta cresta del vástago, ancho del tercer y quinto 

valle, ángulos de la  tercera y quinta rosca y del tercer y quinto valle y la longitud del lado 

mayor del hexágono del abutment; mientras que las demás variables del tornillo y del 

hexágono del abutment fueron analizadas por medio de la prueba U Mann-Whitney. Todas 

las pruebas se realizaron con un nivel de significancia del 5% (p<0.05). 

Se calculó la diferencia de medidas entre los hexágonos de los abutments y sus respectivos 

tornillos de fijación prefabricados y personalizados con el fin de hacer el análisis de 

tolerancia de 25 micras reportado por la norma ISO 286-1 2010.  
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7.CONSIDERACIONES ETICAS 

La Resolución numero 8430 de 1993; por la cual se establecen las normas científicas, técnicas 

y administrativas para la investigación en salud; establece que al ser un estudio in vitro en 

materiales dentales en el cual no se utilizo ningun tipo de muestra invivo o ex vivo  no tiene 

ningun tipo de consideración ética y no se considera una investigacion de riesgo ya que no se 

aplica en animales ni humanos. 
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8.RESULTADOS 

Fase descriptiva 

Al analizar las medidas descriptivamente se observo que los tornillos de fijacion 

personalizados en comparacion con los prefabricados presentaron promedios mas altos en 

longitud del tornillo completo, diametro de la cabeza del tornillo, ancho del valle A y B, 

longitud paso de rosca, angulo de rosca A y B, angulo de valle (a,b)  y angulo de asentamiento. 

(Ver tabla 4) 

Por otra parte, al analizar las medidas del hexagono del abutment en los personalizados todas 

las dimensiones presentaron los mayores promedios en comparacion con los prefabricados 

(Ver tabla 5); sin embargo no se observaron diferencias estadisticamente significativas.  

Fase analitica  

A pesar de que en ninguna de las dimensiones se observó diferencias estadísticamente 

significativas, teniendo en cuenta la norma ISO 286-1 2010, en la cual se establece que el 

valor maximo de tolerancia es de 25 micras; se observo que las mayores diferencias entre los 

tornillos personalizados y prefabricados fueron en las dimensiones:  longitud del tornillo 

completo, longitud parte activa del tornillo, diametro cabeza del tornillo, longitud de cuello 

de tornillo, altura del hexagono del abutment, perimetro del hexagono del abutment, 

diametro maximo hexagonal y diametro menor hexagonal. (ver tabla 6 y 7) 

 

Tabla 4. Comparación de las mediciones entre los tornillos de fijación de los abutments de conexión 

hexagonal interna activa prefabricados y personalizados 

DIMENSIONES 
PERSONALIZADO PREFABRICADO 

Valor p 
Promedio DS Promedio DS 

Longitud tornillo completo* 8902.33 365.71 8786.33 486.17 0.65 

Longitud tornillo parte activa* 5903.96 500.92 5997.34 431.95 0.97 

Longitud cabeza tornillo* 1645.44 58.04 1669.43 52.97 0.132 

Diámetro cabeza tornillo* 1389.92 129.38 1352.51 127.62 0.878 

Longitud de cuello tornillo* 3306.26 317.4 3332.69 295.35 0.677 

Diámetro cuello tornillo* 1691.69 22.05 1694.09 24.34 0.849 

Diámetro mayor del vástago del tornillo* 1978.12 71.14 1982.44 73.94 0.621 

Ancho de la cresta A (3a cresta del vástago) * 41.87 7.66 46.99 8.42 0.172 

Ancho de la cresta B (5a cresta del vástago) * 41.87 7.66 46.99 8.42 0.172 

Ancho del valle A (3er valle del vástago) * 60.97 19.17 56.62 23.47 0.655 

Ancho del valle B (5º  valle del vástago) * 60.97 19.17 56.62 23.47 0.655 
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DIMENSIONES 
PERSONALIZADO PREFABRICADO 

Valor p 
Promedio DS Promedio DS 

Longitud paso de rosca* 396.2 13.98 392.47 14.78 0.54 

Ángulo de rosca A (3ª  rosca superior)ǂ 60.27 0.56 59.78 0.55 0.066 

Ángulo de rosca B (5ª rosca superior) ǂ 60.27 0.56 59.78 0.55 0.066 

Ángulo de valle A (3er valle superior) ǂ 60.25 0.55 60.1 0.6 0.573 

Ángulo de valle B (5º valle superior) ǂ 60.25 0.55 60.1 0.6 0.573 

Ángulo de asentamiento ǂ 120.2 11.02 118.16 9.9 0.94 
* Mediciones en micras µ - ǂ Mediciones en grados o  

 

Tabla 5. Comparación de las mediciones entre los hexágonos de los abutments de conexión hexagonal 

interna activa prefabricados y personalizados 

DIMENSIONES 
PERSONALIZADO PREFABRICADO 

Valor p 
Promedio DS Promedio DS 

Altura Hexágono del Abutment* 1670.22 114.01 1587.92 122.92 0.13 

Perimetro Hexágono del Abutment*   8531.08 172.04 8470.46 144.30 0.472 

Ancho de extensión Hexagonal* 1485.63 26.01 1479.31 23.30 0.545 

Longitud del lado mayor del hexágono* 1556.82 60.88 1542.84 56.85 0.733 

Longitud del lado menor del hexágono* 100.53 28.81 93.89 27.25 0.403 

Diámetro máximo hexagonal* 2420.82 296.23 2355.05 297.49 0.85 

Diámetro menor hexagonal* 1981.67 230.45 2027.94 235.54 0.602 
* Mediciones en micras µ - ǂ Mediciones en grados o  

 

Tabla 6. Diferencia de promedios en micras µ tornillos de fijación 

DIMENSIONES PERSONALIZADO PREFABRICADO 
Diferencia 

en µ 

Longitud tornillo completo 8902.33 8786.33 116* 

Longitud tornillo parte activa 5903.96 5997.34 94* 
Longitud cabeza tornillo 1645.44 1669.43 24 
Diametro cabeza tornillo 1389.92 1352.51 37* 
Longitud de cuello tornillo 3306.26 3332.69 26* 
Diametro cuello tornillo 1691.69 1694.09 3 
Diámetro mayor del vástago del tornillo 1978.12 1982.44 4 
Ancho de la cresta A (3a cresta del vástago) 41.87 46.99 5 
Ancho de la cresta B (5a cresta del vástago) 41.87 46.99 5 
Ancho del valle A (3er valle del vástago) 60.97 56.62 4 

Ancho del valle B (5º valle del vástago) 60.97 56.62 4 

Longitud paso de rosca 396.2 392.47 4 

* Valores > 25 µ. Tolerancia máxima aceptada ISO 286-1 
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Tabla 7. Diferencia de promedios en micras µ hexágonos 

DIMENSIONES 
PERSONALIZADO PREFABRICADO 

Diferencia 
en µ  Promedio Promedio 

Altura Hexágono del Abutment  1670.22 1587.92 83* 

Perimetro Hexágono del Abutment   8531.08 8470.46 61* 

Ancho de extensión Hexagonal  1485.63 1479.31 6 

Longitud del lado mayor del hexágono 1556.82 1542.84 14 

Longitud del lado menor del hexágono 100.53 93.89 7 

Diámetro máximo hexagonal 2420.82 2355.05 65* 

Diámetro menor hexagonal 1981.67 2027.94 46* 

* Valores > 25 µ. Tolerancia máxima aceptada ISO 286-1 
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9.DISCUSION 

En este estudio se evaluaron las caracteristicas dimensionales de tornillos de fijacion y sus 

respectivos hexagonos de los abutments personalizados y prefabricados; analizando un total 

de 20 dimensiones, 13 para el tornillo de fijacion que fueron: las longitudes del tornillo 

completo, de la parte activa, del paso de rosca y de la cabeza y el cuello; los diámetros de la 

cabeza, el cuello y el diámetro mayor del vástago, ancho de la tercera y quinta cresta del 

vástago, ancho del tercer y quinto valle, reportadas en micras (µ)  y los  ángulos de la tercera 

y quinta rosca, tercer y quinto valle y el ángulo de asentamiento, reportados en grados(º); 

mientras que para el hexagono del abutment se midieron 7 dimensiones: altura, perímetro, 

lado mayor, lado menor, diámetro máximo, diámetro menor y ancho de extensión hexagonal, 

reportadas en micras (µ). 

A diferencia de otros estudios, este ha sido el que más dimensiones ha evaluado tanto para 

los tornillos como para los hexágonos; las mismas dimensiones del tornillo de fijación 

evaluadas en este estudio, excepto las longitudes del tornillo completo y de la cabeza, los 

ángulos de la tercera y quinta rosca, tercer y quinto valle y de asentamiento fueron también 

evaluadas por Jaarda et al., [1995]. Por otro lado, los diámetros de la cabeza, el cuello y el 

diámetro mayor del vástago fueron evaluadas por Lang et al., [2003] y la longitud del paso de 

rosca evaluada por Guzaitis et al., [2011]. Para las dimensiones correspondientes a los 

hexágonos de los abutments a diferencia de Binon et al., [1995] y Lang et al., [2003] que 

midieron el diámetro máximo hexagonal del abutment y la altura del hexagono, se evaluó 

además el perímetro, el ancho de extensión hexagonal, la longitud del lado mayor y menor 

del hexagono y el diámetro menor. Estas dimensiones adicionales evaluadas son importantes 

porque la magnitud de la precarga está influenciada directamente por el diseño geométrico 

del tornillo presente en la interfaz implante-abutment que sumado a la precisión del ajuste 

de los componentes de acoplamiento permiten resistir las fuerzas oclusales y evitan 

complicaciones como el aflojamiento del tornillo y el desalojo de la restauración (Siamos et 

al., 2002, Feitosa et al., 2013, Butkevica et al., 2016).  

Al comparar los datos de las dimensiones de los dos grupos tanto para los tornillos como para 

los hexágonos, no se encontraron diferencias estadísticamente significativas; por lo que se 

infiere que se pudo haber cometido un error tipo 2 ya que no fue un tamaño de muestra 
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calculado probabilísticamente sino que fue por conveniencia; sin embargo, con base en el 

parámetro de máxima tolerancia permitido de 25 micras establecido en la norma ISO 286-1 

2010, se pudieron analizar los resultados dándole relevancia clínica al estudio.  

Con base en este parametro se observo que los tornillos de fijacion personalizados 

presentaron discrepancias en longitud del tornillo completo, su parte activa y el diametro de 

su cabeza. Al analizar el impacto clinico de estas dimensiones se observa que son 

características del diseño que influyen directamente en la relación de torque/precarga 

(Jaarda et al., 1995). Estas dimensiones son importantes para lograr el alargamiento del 

tornillo en el momento en el que se está realizando el apretamiento y generar estabilidad en 

el tiempo, es decir; los tornillos más largos con diferentes dimensiones respecto a las 

determinadas por el fabricante darán como resultado un menor alargamiento del cuerpo del 

tornillo debido al aumento del área de superficie; adicional a esto el efecto generado sobre la 

precarga y las variaciones geométricas afectarán también las propiedades mecánicas de los 

tornillos de retención protésicos; por lo cual no se recomienda utilizar un tornillo con 

dimensiones diferentes al fabricante; por otro lado, si  la parte activa del tornillo es de menor 

dimensión se reducirá la presencia de fricción entre los componentes y se generaran 

complicaciones mecánicas y biológicas en la interfaz implante- abutment (Jaarda et al., 1995, 

McGlumphy et al., 1998, Schwarz et al., 2000).  

Hasta el momento no existen estudios que evaluen la tolerancia de sistemas de abutments 

prefabricados y personalizados; no obstante si se han comparado algunas dimensiones en 

sistemas de abutment de diferentes casas comerciales. Butkevica et al., [2016] evaluó la 

longitud completa del tonillo de fijacion de las casas comerciales straumann, Astra Tech, 3i, 

Zimmer Dental, Nobel Biocare y SteriOss y al comparar los resultados se observó que las 

dimensiones fueron menores en este estudio; a pesar de estudiar la misma casa comercial, 

probablemente por la diferencia de métodos utilizados. Por otro lado, las dimensiones 

analizadas por Jaarda et al., [1995] y Lang et al., [2003] que tuvieron diferencia mayor a 25 

micras según la norma ISO 286-1 2010 fueron el diámetro de la cabeza del tornillo, la longitud 

del paso de rosca, el diámetro mayor y el diámetro y longitud del cuello; por el contario el 

ancho de la cresta y el valle no presentaron diferencias mayores. Todo lo anterior sugiere que 

no es viable comparar las dimensiones de los mismos tipos de abutments  fabricados por 
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diferentes casas comerciales debido a que cada una presenta sus propios criterios 

geométricos dimensionales. 

No obstante, existen dos dimensiones estándares para todas las roscas de los tornillos - 

independientemente de la casa comercial que los fabrique que son  los ángulos de las roscas 

y de los valles, los cuales presentan un ángulo promedio estándar de 60  grados establecido 

en la norma ISO 965-1:1998; lo cual permite que el torque de precarga aplicado al tornillo 

alargue el vástago para fijar los componentes metálicos y en este estudio dichos ángulos- 

tanto en los personalizados como en los prefabricados- tuvieron un promedio de 60°.(Shetty 

et al., 2014) 

Al comparar el hexagono del abutment personalizado con el prefabricado se observo que 

todas las dimensiones en los personalizados presentaron los mayores promedios sin ser 

resultados estadisticamente significativos y que la altura del hexagono, el perimetro y el 

diametro superaron el margen de tolerancia de 25 micras establecido por la norma ISO 289-

1 2010.  

Con relación al hexágono del abutment Binon et al., [1995] midió el diámetro máximo 

hexagonal del abutment, el cual al comparar con este estudio presento una diferencia mayor 

a 25 micras y la altura del hexágono no tuvo diferencia con este parámetro; mientras que 

Lang et al., [2003] quien evaluó estas mismas dimensiones mostro que ambas presentaban 

diferencias. 

La validez del rango de tolerancia observada en este estudio para los sistemas de abutments 

de la casa comercial ZimmerBiomet se determinará una vez se puedan comparar con los 

valores de referencia reportados en las fichas técnicas de cada una de estas casas comerciales.  
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10. CONCLUSIONES Y RECOMENDACIONES 

Dentro de las limitaciones de este estudio, se concluyó que: 

1.  No hubo diferencias estadísticamente significativas en la tolerancia de sistemas 

de abutments prefabricados y personalizados.  

2. Sin embargo, con base en el parámetro de máxima tolerancia permitida de 25 micras 

establecido por la norma ISO 286-1 2010 se observó que: 

a. Los tornillos de fijacion personalizados presentaron discrepancias en la longitud 

del tornillo completo, su parte activa y el diametro de la cabeza. 

b. Los hexagonos de los abutments personalizados presentaron discrepancias en la 

altura del hexagono, el perimetro y el diametro. 

3. Se necesitan más estudios de tolerancia que comparen sistemas de abutments 

prefabricados y personalizados con números de muestras más grandes, y estudios  

complementarios que comparen la precarga, y aflojamiento de los tornillos entre 

estos dos sistemas. 
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